
 
 
 
 
 
 
May 7, 2012                                                          emailed to: tribalpolicy@resources.ca.gov 
 
Mr. John Laird, Secretary and 
Liane Randolph, General Counsel and Deputy Secretary 
California Natural Resources Agency 
1416 9th Street, Suite 1311 
Sacramento, CA 95814 
 
Attached are Tübatulabal Tribal comments to proposed “NATURAL RESOURCES AGENCY 
TRIBAL CONSULTATION POLICY - DRAFT CIRCULATED FOR PUBLIC COMMENT 
APRIL 2012”.  Our Tribe appreciates the opportunity to provide input to the important 
agency-wide Tribal related policy.  We understand that this policy does not impact our 
sovereignty or existing CA Tribal compacts. We understand that this policy is based on 
Governor Brown’s Executive order “B-10-11, which provides, among other things, that it is 
the policy of the administration that every state agency and department subject to executive 
control to implement effective government-to-government consultation with California Indian 
tribes and tribal communities”. 
 
As a non-federally recognized Tribe, we appreciate the inclusion of “non-federally” 
recognized Tribes in this proposed policy and policy review process. If there are any 
additional questions regarding our Tribal comments, feel free to contact our Tribal Office 
(760) 379-4590. 
 
Sincerely, 

 
 
 
 
Dr. Donna Miranda-Begay 
“timiwal” Tribal Chairwoman 
 
 
 
cc: Tübatulabal Tribal Council and Members 
      Cynthia Gomez, CA Governor’s Indian Affairs Advisor 
      California Inter-Tribal Council of California 
      California Native American Heritage Commission 
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Tübatulabal Tribe’s Comments to the Proposed 
“NATURAL RESOURCES AGENCY TRIBAL CONSULTATION POLICY 

DRAFT CIRCULATED FOR PUBLIC COMMENT APRIL 2012”. 
 
Introduction 
 
The Tübatulabal Tribe is located in Kern Valley, California.  We have 280 enrolled Tribal Members and 8 Tribal Allotments (160 
acres each, lands held in trust by the U.S. Bureau of Indian Affairs).  Our allotment lands and traditional territories include lands 
managed by CA Department of Fish and Game, U.S. Bureau of Land Management, U.S. Forest Services, U.S. Army Corps of 
Engineers, and Kern Council of Governments, and private ranch lands owners.  We have a Tribal Representative on California 
EPA and California Department of Water Resources – Tribal Advisory Committees.  We also have Tribal Members who have 
worked for CA Natural Resources Agency’s Departments and have assisted in providing the following comments to the proposed 
policy. 
 
Preamble 
 
In 2011, the United States has issued their support for the 2007 United Nations Declaration on the Rights for Indigenous Peoples.  
In 2011, California Governor Brown issued executive order “B-10-11” that has directed all State Agencies to develop and 
implement effective government-to-government with California Tribes and Tribal Communities.  In the past few years, there was 
the passage of the Marine Life Protection Act (MLPA), recent proposed planning for changes in California water ways (federal and 
state water system infrastructures, Shasta and Lake Isabella Dam, Central Valley – Delta Water ways), fast pace approval and 
development of “green” energy (i.e., wind, geothermal, solar, biomass), and California legislation direction to improve California air 
quality and becoming less reliant on fossil fuels. Although, these legislative, water planning, and “green” directives appear to have 
good intent, they have negative impacts on traditional uses and access to Native foods, medicines, cultural life-ways, and other 
traditional uses.  California Natural Resources plays a significant role in understanding the Tribal perspectives and impacts of 
international, national, tribal, state, and local policies and mandates. In consideration of this preamble context, our Tübatulabal 
Tribe provides the following tribal comments.  We also understand California State’s limited funding and challenged resources to 
fully implement this policy. 

 
  



Comments 
 
Proposed Policy Recommended Changes Tübatulabal Tribal Comments 

NATURAL RESOURCES AGENCY TRIBAL 
CONSULTATION POLICY DRAFT 
CIRCULATED FOR PUBLIC COMMENT APRIL 
2012 

Natural Resources Agency – Working Effectively 
with California Native American Tribes 

This policy title change reflects communicating, 
collaboration, and if necessary, consultation with 
California Native American Tribes and California  
Tribal Communities. 
 
Include the following definition for “California Native 
American Tribe” signifies all Indigenous Communities of 
California, including those that are federally non-
recognized and federally recognized, and those with 
allotment lands, regardless of whether they own those 
lands. 
 
Include definitions listing, goals, and “high level” 
action plan for implementing this policy (including the 
establishment of Agency Tribal Liaison position who 
would report to Natural Resources Agency – 
Secretary or Executive Level). 

Purpose of the Policy  
 
The mission of the California Natural Resources 
Agency is to restore, protect and manage the 
state's natural, historical and cultural resources 
for current and future generations using creative 
approaches and solutions based on science, 
collaboration and respect for all the communities 
and interests involved. California Native 
American tribes Tribes and tTribal communities 
have sovereign authority over their members 
and territory, and a unique relationship with 
California’s resources. All California California 
Native American tribes Tribes and tribal 
communities, whether federally recognized or 
not, have distinct cultural, spiritual, 
environmental, economic and public health 
interests.  
 
On September 19, 2011, Governor Edmund G. 
Brown, Jr. issued Executive Order B-10-11, 
which provides, among other things, that it is the 
policy of the administration that every state 

 
 
……. California Native American tribes Tribes 
and tribal Tribal communities have sovereign 
authority over their members and territory, and a 
unique relationship with California’s resources. 
natural resources in California. All California 
Tribes and tribal communities, whether federally 
recognized or not, have distinct traditions, 
cultural, spiritual, traditional knowledge, 
environmental, economic and public health 
interests.  
 
 
 
 
 
 
 
No major changes recommended for this 
paragraph.   
 
 

 
 
Appreciate “whether federally recognized or not”, in 
this policy.  Our Tribe also understands that there may 
be Natural Resources Agency federal funded 
programs or grants that may be specifically for 
federally recognized Tribes. 
 
Upper case “Tribe” and “Tribal” – unique sovereign 
status. 
 
Be consistent on “California Native American” vs. 
California Indian or other descriptions. 
 
 
 
 
 
 
 
 
 
 



agency and department subject to executive 
control to implement effective government-to-
government consultation with California Indian 
California California Native American  tribes 
Tribes and tTribal communities.  
 
The purpose of this policy is to ensure effective 
government-to-government consultation 
between the Natural Resources Agency, the 
departments of the Natural Resources Agency, 
and Native American California Native American 
tribes Tribes and tribal communities to further 
this mission and to provide meaningful input into 
the development of regulations, rules and 
policies that may affect tribal communities. It is 
only by engaging in open, inclusive and regular 
communication efforts that the interests of 
California’s tribes California Native American 
Tribes and tribal communities will be recognized 
and understood in the larger context of complex 
decision-making. Each department in the 
Natural Resources Agency has a different 
statutory mandate and, in some cases, may 
have consultation, communication, collaboration 
or interaction requirements imposed on it by 
other laws or regulations. This policy defines 
provisions for improving Natural Resources 
Agency consultation, communication and 
collaboration with California Native American 
tribes Tribes to the extent that a conflict does 
not exist with applicable law or regulations. 
Department is defined as any department, 
board, commission, council or conservancy 
subject to executive control.  
 
This policy anticipates a deliberate process that 
aims to create effective collaboration and 
informed decision-making where all parties 
share a goal of reaching a decision together. All 
parties in the process should promote respect, 
shared responsibility and an open and free 
exchange of information. The inclusion 
California Native American tribes Tribes and 
tTribal communities at all stages of the decision-

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Recommendation in changing the order of 
“….This policy defines provisions for improving 
Natural Resources Agency consultation, 
communication and collaboration…..” to “…This 
policy defines provisions for improving Natural 
Resources Agency communication, 
collaboration, and consultation”….   
 
 
 
 
 
 
 
 
 
 
No major changes recommended for this 
paragraph.   
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Reflects progressive action order of working with 
California Native American Tribes.   
 
There will be a need to include federal definition of 
“consultation” with Federally Recognized Tribes. “In 
recognition of that special relationship, pursuant to 
Executive Order 13175 of November 6, 2000, 
executive departments and agencies (agencies) are 
charged with engaging in regular and meaningful 
consultation and collaboration with tribal officials in the 
development of Federal policies that have tribal 
implications, and are responsible for strengthening the 
government-to-government relationship between the 
United States and Indian tribes” – found at U.S. White 
House web site: http://www.whitehouse.gov/the-press-
office/memorandum-tribal-consultation-signed-
president  
 
 
 
 
 
 
 
 
 
 
 
 

http://www.whitehouse.gov/the-press-office/memorandum-tribal-consultation-signed-president
http://www.whitehouse.gov/the-press-office/memorandum-tribal-consultation-signed-president
http://www.whitehouse.gov/the-press-office/memorandum-tribal-consultation-signed-president


making process will promote positive, 
achievable, durable outcomes.  
 
This policy is intended solely for the guidance of 
employees of the Natural Resources Agency 
and its departments and does not extend to 
other governmental entities, although the 
Natural Resources Agency encourages 
cooperation, education and communication on 
the part of all governmental entities. This policy 
is not intended, and should not be construed, to 
define the legal relationship between the Natural 
Resources Agency and its departments and 
California Native American tribes Tribes and 
tTribal communities. This policy is not a 
regulation, and it does not create, expand, limit, 
waive, or interpret any legal rights or obligations.  
 
The sSecretary of the Natural Resources 
Agency hereby directs the agency staff and 
departments to undertake implementation of the 
policy as set forth below 

 
No major changes recommended for this 
paragraph.   
 
 
 
 
 
 
 
 
 
 
 
 
 
No major changes recommended for this 
paragraph.   
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Implementation of the Tribal Consultation Policy  
 
1. Outreach. The agency and departments must 
identify the California Native American tribes 
Tribes to consult at the earliest possible time in 
the planning process and allow a reasonable 
opportunity for California Native American tribes 
Tribes to respond and participate. Each 
department is responsible for meaningful 
consultation with California Native American 
tribes Tribes that promote regular and early 
consultation through communication and 
collaboration. Each department will identify 
participants in the process - including the 
decision-makers and staff with an appropriate 
level of responsibility - that can ensure that tribal 
concerns will be brought forward.  
 
Each department shall disseminate public 
documents, notices and information to California 
Native American tribes Tribes. The documents shall 
be made readily accessible to California Native 

Action Plan to Implement Tribal Consultation 
Policy 
 
1. Outreach. <Add> In coordination with CA 

Governor’s Indian Advisor, California 
Native American Tribes, and California 
Native American communities, the Natural 
Resource Agency will develop and 
maintain central mailing, listserv, and web 
based Natural Resources Tribal Affairs web 
site. 

 
 
 
 
 
 
 
 
 
No major changes recommended for this 
paragraph.   

Title Change Recommended 
 
 
Expand on Outreach – provide recommended 
methodology or tool. 
 
Web page should include the Tribal perspective and 
context.  Host a Webinar to help build this new web 
site. 
 
 
 
 
 
 
 
 
 
 
 
 
 



American tribes Tribes. Notification should include 
sufficient detail of the topic to be discussed to allow 
tTribal leaders an opportunity to fully engage in a 
substantive dialogue. In the event the department 
makes an attempt to initiate contact and does not 
receive a response, the department should make 
reasonable and periodic efforts throughout the 
process to repeat the invitation. 
 
Each department should conduct meetings, 
outreach and workshops at times and locations 
that facilitate tTribal participation as much as 
possible. The departments will be open to 
communication opportunities initiated by 
California Native American tribes Tribes and 
seek opportunities for collaboration by 
communicating regularly with California Native 
American tribes Tribes. Each department should 
establish a mechanism to request relevant and 
available information, studies and data from 
California Native American tribes Tribes when 
conducting research or studies that relate to, or 
could impact, tribal lands or cultural resources.  
 
2. Tribal Liaisons. Each department should 
designate a tribal liaison, or liaisons, to serve as 
the central point of contact for California Native 
American Indian tribes Tribes and Tribal 
Communities. The role of the tTribal Liaison will 
be to ensure that department outreach and 
communication efforts are undertaken in a 
manner consistent with this policy.  
 
3. Tribal Liaison Committee. The Agency hereby 
designates the Natural Resources Agency Tribal 
Liaison Committee consisting of department 
tribal liaisons that will meet on a regular basis in 
the Office of the Secretary to review tribal 
consultation efforts and opportunities in the 
departments and share information.  
 
 
 
4. Access to Contact Information. The agency 

 
 
 
 
 
 
 
 
 
No major changes recommended for this 
paragraph.   
 
 
 
 
 
 
 
 
 
 
 
 
 
No major changes recommended for this 
paragraph.   
 
 
 
 
 
 
 
<Insert> Tribal Advisory Committee (vs. Tribal 
Liaison Committee) shall be established to meet 
and work with appointed Natural Resources 
Tribal Liaisons.   
 
 
 
 
 
 
See inserted text changes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Our Tribe recommends that Natural Resource Agency 
create a Tribal Advisory Committee, similar to 
CalTrans and CalEPA.  There is an establish TAC 
with CA Department of Water Resources who have 
been helping with CA State Water Planning.  
However, beyond planning – there needs to be a TAC 
focus to address current day Natural Resources 
Agency operational related Tribal issues and 
solutions. 
 
Recommend to work with both Governor’s Tribal 
Advisor and Native American Heritage Commission to 



shall work with the Governor’s Tribal Advisor 
and Native American Heritage Commission to 
maintain a contact list of tTribal representatives 
from federally-recognized and non-federally 
recognized California Native American tribes 
Tribes and California Tribal Communities.  
 
5. Training. The agency will provide training to 
Tribal Liaisons and executive staff, managers, 
supervisors and employees on implementation 
of this policy.  
 
 
 

 
 
 
 
 
 
 
<Add> Training curriculum should be 
coordinated and developed in collaboration by 
California Native American Tribes, California 
Native American Tribal Communities, Natural 
Resources Agency Tribal Liaison Committee (or 
Tribal Advisory Committee), Executive, staff, 
managers, supervisors and employees.  Core 
topics should include CA Native American 
History, Cultural Competency, Environmental 
Justice, historical legislation that has impact 
California Native American Tribes and California 
Native American Tribal Communities.   
 
 
 
 

maintain contact listings. 
 
 
 
 
 
California Inter-Tribal Council of California, National 
Indian Justice Center, and California Indian Legal 
Services can offer great insight and training service to 
address this required training. 
 
Recommendation – Appointed Tribal Liaisons should 
have changes made to their job descriptions and 
Tribal Liaison should have access to their 
Department’s Director. 

 New Action / Implementation Process 
 
6. Accountability and Reporting – Natural 
Resources Agency will publish executive and 
department based “Working with California 
Native American Tribes and Tribal 
Communities” Annual Report.  This report will 
include the status of the implementation of this 
policy, challenges and solutions, and 
recommendations.  This report should be co-
authored by newly established CA Natural 
Resources Tribal Liaisons Committee or Tribal 
Advisory Committee. 

Recommend to add the new Action / Implementation 
Process #6.   
 
In CA state government, California Native American 
Tribes have experienced working with several state 
agencies and departments – however, there is rarely 
an annual report that describes the effort, 
achievements, challenges, solutions, and Tribal 
perspectives of working with California Native 
American Tribes and California Tribal Communities. 

 Include definitions, disclaimer, guiding 
principles, and statutory references. 

Recommend to review Cal/EPA “Working with 
California Indian Tribes” policy format – it also 
includes definitions, disclaimer, guiding principles, and 
statutory references. Cal/EPA web site: 
www.calepa.ca.gov/Tribal/Documents/CIT01Policy.pdf  
 

 

http://www.calepa.ca.gov/Tribal/Documents/CIT01Policy.pdf


 
 


